IGlI Wealth Management Portal

Wealth Management (WM) is a highly personalized investment advisory service that
requires active involvement by Wealth Managers to formulate and implement
customized investment strategies for each individual client. Given that these accounts
are owned by individuals rather than corporations, with a low average level of investing
knowledge and expertise, the feedback and reporting requirements on a Wealth
Manager may become quite time consuming. Thus, the WM Portal is a very important
tool to automate various client request functions to provide a better client experience
focusing on responsiveness, transparency and convenience. For the WM business, the
portal is vital to increase efficiency by reducing time spent by a wealth manager in
dealing with client requests, allowing them to focus on improving internal coordination
and remaining vigilant for new investment opportunities. The goals of this portal can be
summarized as below:

Objectives:

e Inform potential customers about IGI WM services

e Provide a platform for the client to be routinely engaged with the IGI WM
customer experience that can be accessed through any web compatible medium

e Automation of routine client requests through a web based service (accessing
information / market research, performance reporting, document retrieval, etc.)

e Create time for department resources to engage in tasks that improve process
efficiency, with the potential for greater ROI

e Set a standard for convenient, personalized web based client tools that will be
difficult for competitors to replicate

e Provide Wealth Managers with a Customer Management System or CMS
(internal to the portal) to analyze web usage statistics and perform
housekeeping tasks through an online medium

Basic Functionality
There will be separate site areas for existing and potential clients. Potential clients who
visit the website will view static content pages with details about IGI FS, IGI WM
Products & Services, general performance and contact information. The actual client
portal is meant to provide a range of client functions, listed with interactivity options as
below:
1. Account & Personal Profile (View / Update / Print / Download)
2. View Portfolio Performance (View / Customize View / Save View Settings / Print /
Download)
3. Access Market Research and News (View / Sort By / Save Sort By Settings / Print
/ Download)
4. Document Retrieval (View / Download / Print)
View Credit Summary (View / Print / Download)
6. Client Personal Tools: Inbox, Meeting Scheduler, Personal Settings & Preferences
(View / Print / Download / Save & Update Settings)
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7. Interactivity: Online Messaging w Active (Logged On) WM

8. VIP Area for benefits, promo offers for WM clients (Internally Updated w CMS)

9. WM Business Intel: Activity Log for each client session (for Internal reporting and
service improvement)

Process

All Wealth Managers will have a unique ID/Password that allows them to access the
CMS portion of the portal. Potential clients can access static pages of the website, and
clients can access to their portfolio information through their own profile. These are the
step for various portal specific processes:

e Wealth Manager Accounts

1.

Head of WM Department has an account option that allows him/her access
to all client profiles

HoD can set account privileges of other wealth managers by specifying the
clients (by NIC) whose information can be accessed

Wealth Managers have their accounts created by IT, and will be allowed
access only to their own client’s information

Only the Wealth Manager for a specific client can upload their Fund Manager
report or Personal Documents

All Wealth Manager accounts can upload market research reports and create
VIP benefit promos

e Client Registration Process

6.

7.

8.

9.

Receive all client documentation relevant to their account opening (and
transfer of investment authority to IGl Investment Bank)
Compilation of all relevant details for uploading to Portal:
Asset Allocation between asset classes up to instrument level
Client and Account Information
Credit Lines Information
Client Starting Preferences & Settings
0 Copies of all documents relevant for client use
Create User ID / Password + Upload all Client Info (As above) to their User
Profile
Communicate Profile ID / Password to client
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e Market Research & News Items Uploading

1.

Clients set their market reporting view preferences (by sector, date, tags,
specific date range, etc.)

WM uploads market research reports to portal through CMS, tagged by
sector / category

News Reports uploading will be automated, but will be tagged everyday by a
Wealth Manager by sector / category

When the client clicks on the Market Insight tab, the system displays the
market research reports or news items according to the client’s defined
settings

e Document E-Filing & Uploading Fund Manager’s Reports

1.

The wealth manager searches for the client by NIC # using CMS



2.

Selecting the client user profile, the wealth manager has the option to upload
more documents to their profile (wealth manager can download documents
from this view as well)
At the upload option, the wealth manager enters the following information
before selecting the document file from a menu

0 Client Name
NIC
Document Name to be Displayed
Category for filing (select from category from drop down menu)
Clients will now be able to access a personal document from their E-
Filing page, where it is displayed according to asset class and date
uploaded

O O 0O

e VIP Benefits Updating

1.
2.

Wealth Manager accesses VIP Benefit Area through CMS

He / She types in Offer Caption, Offer Details and Offer Validity Date, VIP Tier
for this Offer (only visible to clients within specified AUM Tier), and may
upload a picture for display as well

Offer is posted to the Portal, where eligible clients can view it. Ineligible
clients will not have the offer displayed at their VIP Benefits page

e Access to Client Usage Statistics

1.
2.

Wealth Manager logs into the CMS using their account

On Web Usage Statistics page, the Wealth Manager can run a query by date
range, site area, client IDs, or AUM tiers

Portal generates a report of the performance of the site layout, client
interest in specific site areas through time spent or number of times
accessed, usage of specific tools and services, file download history, etc.

Site Structure and Functional Screen Layout
The site consists of two secure areas accessible only by unique login ID / password, and
one area accessible by anyone surfing the web. Site structure is as below:

Public Site — IGl Wealth Management Home

Wealth
Management
HOME
WM .
About About Products & Client Performance Contact
IGI FS IGI WM . Login At a Glance Us
Services

This site hosts static content on IGI FS, WM and details of Products & Services offered.
Performance reports will be prepared and updated on a quarterly basis, and potential
customers can access contact details for IGI WM from here. A link to the Client Login
area will be visible on all pages of this site.



Secure Client Site — IGlI Wealth Management Client Portal

Client
Home
[
[ [ I [ |
Portfolio Market Document Credit Lines Personal
View Insight E - Filing Summary Area

This site will accessible only through a secure login with the client’s unique User ID and
Password. Each area is carefully designed to maximize the ease and convenience of
navigation and the accessibility of various options on the site. As this portion of the
portal is built specifically for the client, a conceptual level of design for each page is
given below, along with the functions available to the user:

WM Client Home Page

Secure Wealth Manager Site

Wealth Mgr.
Home
[ [ [ |
HoD Client Profile Document Usage VIP Promo
Options Viewer Uploading Statistics Updater

Market Rpts.
News Tagging

Fund Mgr. Rpt.
Client Documents

Client NIC Required——No Client NIC Required—————

Although the Wealth Manager site is not accessible from the I1GI Wealth Management
Home Page, any information uploaded or changed here is reflected in real time on the
WM Client Portal, so these are integrated into the same application. As this area is
meant for wealth managers and not the client, their design layout is not important as
long as all required functionality is maintained. The following section is a visual
representation of the conceptual look & feel of the client website to simulate the user
experience planned for IGI WM customers.

Functionality of Individual Pages
Client Pages
1. Client Home: This page will have the option to display account information or
personal information in the sidebar, which reflects records created at the time of
account opening or last revised information. The display area has heads for
updates on the internal pages, and information to be displayed has been
included as below (subject to updates with further requirements):



Personal Profile:
i. Client Name
ii.  Date of Birth
iii. NIC#
iv. NTN #
v.  Contact Information
1. Address (Home / Office)
2. Telephone (Home / Office / Cell)
3. Email (Personal / Official)
Account Profile:
i. Account#
ii.  Portfolio Size (AUM)
iii.  Asset Allocation (expandable heads for each asset class)
Content Display Area:
i. Portfolio View:
1. Latest NAV of Portfolio (Real Time)
2. Biggest Gainers / Losers of Today (Real Time Stock Quote)
ii.  Market Insight:
1. Latest Headlines (Top 2 Stories Displayed)
2. Latest Research (Top 2 Reports Displayed)

iii.  Document E-Filing:
1. Last three uploaded documents, with Date/Time of

uploading

iv.  Personal Area
1. # of New Msgs in Inbox
2. # of Meetings Scheduled for Today
3. # of New Special Offers in VIP Area (since last login)

Chat with your WM:

i. At the bottom of the sidebar is a link to chat with the client’s
WM. This displays the WM’s online/offline status, and if online
the WM can chat with the customer via an instant messaging
service

My Personal Page: This page is made for client specific functions like Inbox,
Meeting Scheduler, Personal Profile (View and Update), Site Settings (View and
Update), and a VIP Offer Area

a.

Inbox: This area displays the # of new messages in the client’s mailbox.
Clicking this icon/link will display all messages with standard options for
client action.

Meeting Scheduler: This allows the client to schedule meetings and
receive automated reminders. The icon/display shows the # of meetings
scheduled today, this week, and pending requests. Clicking on the
icon/link will display standard actions for this service.

Personal Profile: All fields as listed above can be updated from this area
by the Client.



d. Site Settings: Various site customization options are displayed initially. On
a click, the client can set notification options (by SMS, Email or Phone) for
various services on the site, as well as customize display options for the
News Feed and Research Reports area. Further options may be added for
client customization.

e. VIP Areas: This area shows all applicable VIP promotions for the client.
These can be in the form of printable PDF files or simple click to avail
options.

3. Portfolio View: This page displays all information regarding the performance of
various investments for the client portfolio. There are two views available to the
client, one is graphical and the other is a tabular format. The two options are
available at a click on the first page, and display settings are to be updated and
saved as last viewed. Downloading and Print options are available.

a. Graphical View: The client can choose to display a trend of returns on
various asset classes, both at the aggregate level as well as for individual
securities in their portfolio. The client can also choose a date range for
the returns graph, and all trend lines displayed are color coded according
to their returns above or below an agreed benchmark. The graph view
reflects real time values.

b. Tabular View: This view has the same expandable heads of asset classes,
down to the individual security level. Returns are displayed in real time
for various asset classes with their Book Value, Market Value, the
Benchmark Return for each asset class, and the Current Return. All values
are real time, and client has the option to set their display range.

4. Market Insights: This page displays all reports and news feeds that are relevant
to the client. The client can go to the Site Settings page (in Personal Area) to
change the priority of news and research reports relating to various sectors, the
number of items displayed on each page, and the archive settings for his
account. The client also has the option to flag news items and reports of interest
to him/her into their ‘My Research’ or ‘My News’ category, which is accessible by
a simple click. Downloading and Print options are available.

5. Document E-Filing: This page shows all available documentation categories for
which client documents are held on file. The client can access scanned copies
from this page for any document submitted to or required from IGl, and options
for Download and Print are available.

6. Credit Lines Summary: This page displays all existing borrowing (credit) lines
active for the customer in a tabular format, with options to Print or Download
the information.

Visual Representations of the above functions are displayed on the following pages.
Note that the Static pages (User Login not required) will be implemented as per the
norm, and the Wealth Manager pages’ functional processes have already been defined
in previous sections.



Client Home:

Header + Graphic Area + IGI WM Logo

Portfolio
View

Market
Insight

Document
E — Filing

Credit Lines

Summary Area

Personal

Welcome Client!

Personal Profile

Nav. Path > Client Home (Hyperlink)

Portfolio View
NAV: 14.5%
Biggest Gainer: HUB 4.5%
Biggest Loser: ENGRO 2.3%

Document E-Filing
Last Uploaded <Date/Time>
Last Uploaded <Date/Time>
Last Uploaded <Date/Time>

Market Insight
Latest Headline <Date/Time>
Latest Report  <Date/Time>

Credit Lines
Current Borrowing Limit
Next Payment: PKR 15,678
Payment Due: <Date/Time>

Personal Area Icon / Link
- 3 New Messages in Inbox
- 2 Meetings Today
- 1 New Special Offer!

Account Profile
e Account #
e Portfolio Size (AUM)
e Asset Allocation:
— Fixed Deposit
= Govt. Securities
= Deposit A/C
= Shariah Compliant
= TFCs
Equity
= Mutual Fund ABC
= Directly Managed
= Shariah Compliant
= Foreign MF XYZ
Commodities
Real Estate
Insurance Coverage
e Chat with your WM (Online)

+ 1+ 1+

My Personal Page:

Header + Graphic Area + IGI| WM Logo

Portfolio Market Document )\ Credit Lines Personal Welcome Client!
View Insight E - Filing Summary Area Personal Profile
Home > Personal Area Account Profile
Message Inbox Meeting Scheduler * ﬁccff“?t ‘: UM
[ ]
- 5 New Messages - 1 Meeting at 4:30pm today ortio 'I‘T ize ( ' )
- 2 Meetings this Week * Asse;lA gcstlon..
- 1Pending Meeting Request - Fixed Deposit
= Govt. Securities
= Deposit A/C
Personal Profile Site Settings = Shariah Compliant
- View Personal Info - Set Notification Options " TFCS
- Edit Personal Info - Customize News Feed - Equity
- Print Personal Info - Customize My Research ® Mutual Fund ABC
= Directly Managed
= Shariah Compliant
VIP Area = Foreign MF XYZ

- Special Offers
- VIP Event Passes

Commodities

Real Estate
Insurance Coverage
e Chat with your WM (Online)

+ + 1+




Portfolio View — Graphical:

Header + Graphic Area + IGI WM Logo

Document
E — Filing

Market
Insight

Portfolio
View

Credit Lines
Summary

Personal

Welcome Client!

Area

Personal Profile

Home > Portfolio View > Graphical

Graphical View Tabular View
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Print | Downlg

Set Date Range: [ ] 1 Dav[ 11 Week[ 1M [J3m[dem[]1 vr[ custom

Clex [ Foreign Investments [ Real Estate

Display Trend: [ Total Portfolio [ Fixed Return [ Equity O] Commaodity

Account Profile
e Account #
e Portfolio Size (AUM)
e Asset Allocation:
- Fixed Deposit
= Govt. Securities
= Deposit A/C
= Shariah Compliant
= TFCs
- Equity
= Mutual Fund ABC
= Directly Managed
= Shariah Compliant
= Foreign MF XYZ
Commodities
Real Estate
+ Insurance Coverage
e Chat with your WM (Online)

+

Portfolio View — Tabular:

Header + Graphic Area + IGI WM Logo

Portfolio Market Document \ Credit Lines Personal Welcome Client!
View Insight E — Filing Summary Area Personal Profile
Home > Portfolio View > Tabular Print | Downlg Account Profile
e Account #
. . . e Portfolio Size (AUM
Tabular View Graphical View ,( )
ook Yo T " c e Asset Allocation:
00 arket enchmar urrent : .
Investment Instrument Val val R % R o - Fixed Deposit
alue alue eturn % eturn % = Govt. Securities
GSS 4,567,890 7,000,000 15% XYZ2% - DeF’C"Sit A/C '
Deposits abc Abc Abc Abc = Shariah Compliant
TFCs def Def Def Def = TFCs
Shariah Compliant ghi Ghi Ghi Ghi - Equity
= Mutual Fund ABC
Mutual Funds = Directly Managed
Direct qu“ty Similar to Similar to Similar to Similar to above = Shariah Compliant
Commodity .
X above above above * Foreign MF XYZ
Foreign Investment Commodities
Real Estate

Set Date Range: ] 1 Dav ] 1 Week ] 1M ] 3M ] 6M ] 1 Yr|:| Custom

+ + 1+

Insurance Coverage
e Chat with your WM (Online)




Market Insight — Research View:

Header + Graphic Area + IGI WM Logo

Portfolio Market Document ) Credit Lines Personal Welcome Client!
View Insight E — Filing Summary Area Personal Profile
Home > Market Insight > Market Research Account Profile
e Account #
Market Research News & Headlines e Portfolio Size (AUM)
Date e Asset Allocation:
Sector & Title Uploaded Select Print | Download - Fixed Deposit
] = Govt. Securities
Today’s Reports: . - - = Deposit A/C
Research Report Title 1 Date/Time Print Download = Shariah Compliant
Research Report Title 2 Date/Time | Print Download
Research Report Title 3 Date/Time d Print Download " TFCs
P - Equity
Energy & Power: = Mutual Fund ABC
Last Uploaded Report Title 1 |  Date/Time O Print Dowin:oaj " Directly Managed
Last Uploaded Report Title 2 | Date/Time O Print Download * Shariah Compliant
Fertilizer: = Foreign MF XYZ
Last Uploaded Report Title 1 | Date/Time Il Print Download Commodities
Real Estate

Next Page | 2 | 3 | Last

Add Selection to My Research

Go To Market Research Archive

Go to My Research

+ + 1+

Insurance Coverage
e Chat with your WM (Online)

Market Insight — News View:

Header + Graphic Area + IGI WM Logo

Portfolio Market Document \ Credit Lines Personal Welcome Client!
View Insight E — Filing Summary Area Personal Profile
Home > Market Insight > News & Headlines Account Profile
R e Account #
News & Headlines Market Research « Portfolio Size (AUM)
D i
Sector & Title ate Select Print | Download * Asset Allocation:
Uploaded - Fixed Deposit
Today’s Headlines: = Govt. Securities
News Headline Title 1 Date/Time O Print Download = Deposit A/C
News Headline Title 2 Date/Time O Print Download ®* Shariah Compliant
News Headline Title 3 Date/Time O Print Download » TFCs
- Equity
Energy & Power: = Mutual Fund ABC
Latest News ltem Title 1 Date/Time O % BOWi”:Oa‘; * Directly Managed
Latest News Item Title 2 Date/Time O Print zownload = Shariah Compliant
Fertilizer: = Foreign MF XYZ
Latest News Item Title 1 Date/Time O Print Download Commodities
Real Estate

Next Page | 2 | 3 | Last

Add Selection to My News

Go To News Archive

Go to My News

+ I+

* Insurance Coverage
e Chat with your WM (Online)




Document E-Filing Page:

Header + Graphic Area + IGI WM Logo

Market
Insight

Document
E — Filing

Portfolio
View

Credit Lines
Summary

Personal
Area

Welcome Client!

Personal Profile

Home > Document E-Filing > Fund Manager’s Reports

Account Statements Fund Manager’s Rpt.

Insurance Docs

Investment Docs. Estate / Trust Docs

Forms / Other

Account Profile
e Account #
e Portfolio Size (AUM)
e Asset Allocation:
— Fixed Deposit
= Govt. Securities
= Deposit A/C

Fund Manager’s Reports (Category Selected on Click) * Shariah Compliant
Document Title Date Added | Print | Download = TFCs
- Equity
= Mutual Fund ABC
Latest Fund Manager’s Report Jan Date/Time Print | Download = Directly Managed
Latest Fund Manager’s Report Dec Date/Time Print | Download = Shariah Compliant
Latest Fund Manager’s Report Nov Date/Time | Print | Download = Foreign MF XYZ
+ Commodities
+ Real Estate
* Insurance Coverage
e Chat with your WM (Online)
Credit Lines Summary:
Header + Graphic Area + IGI WM Logo
Portfolio Market Document \ Credit Lines Personal Welcome Client!
View Insight E - Filing Summary Area Personal Profile

Home > Credit Lines Summary

Print | Download PDF

Summary of Outstanding Limits on Credit Lines
Facility (Limit) Balance Markup % | Payment | Payment Due
Limit A Balance A A% Payment A Due Date
Limit B Balance B B % Payment B Due Date

Account Profile
e Account #
e Portfolio Size (AUM)
e Asset Allocation:
— Fixed Deposit
= Govt. Securities
= Deposit A/C
= Shariah Compliant
= TFCs
- Equity
= Mutual Fund ABC
= Directly Managed
= Shariah Compliant
= Foreign MF XYZ
Commodities
Real Estate
* Insurance Coverage
e Chat with your WM (Online)

+ I+




